5 EXCAVATION IN CLAY

This tutorial describes the construction of an excavation pit in soft clay. The pit is a relatively small excavation of 12 by 20 m, excavated to a depth of 6.5 m below the surface. Struts and walings are used to prevent the pit to collapse. After the full excavation, an additional surface load is added on one side of the pit.

Hint: In the Professional version, ground anchors consisting of embedded piles and node-to-node anchors will be used in addition to prevent the pit to collapse.

The proposed geometry for this exercise is 80 m wide and 50 m long, as shown in Figure 5.1. The excavation pit is placed in the center of the geometry. Figure 5.2 shows a cross section of the excavation pit with the soil layers. The clay layer is considered to be impermeable.
Objectives:

- Using the Hardening Soil model
- Using interface features
- Defining over-consolidation ratio (OCR)
- Changing water conditions
- Selection of stress points to generate stress/strain curves
- Viewing plastic points

![Diagram of soil layers](image)

Figure 5.2 Cross section of the excavation pit with the soil layers

### 5.1 GEOMETRY

To create the geometry model, follow these steps:

**Project properties**

- Start a new project.
- Enter an appropriate title for the project.
- Define the limits for the soil contour as $x_{\min} = 0$, $x_{\max} = 80$, $y_{\min} = 0$ and $y_{\max} = 50$. 


5.1.1 DEFINITION OF SOIL STRATIGRAPHY

In order to define the soil layers, a borehole needs to be added and material properties must be assigned. As all soil layers are horizontal, only a single borehole is needed.

Create a borehole at (0 0 0). The Modify soil layers window pops up.

- Add 3 layers with bottom levels at -1, -9.5 and -20. Set the Head in the borehole column to -6 m.

Open the Material sets window.

- Create a new data set under Soil and interfaces set type.
- Identify the new data set as "Soft Clay".
- From the Material model drop-down menu, select Hardening Soil model. In contrast with the Mohr-Coulomb model, the Hardening Soil model takes into account the difference in stiffness between virgin-loading and unloading-reloading. For a detailed description of the Hardening Soil model, see the Material Models Manual.
- Define the saturated and unsaturated unit weights according to Table 5.1.
- In the Parameters tabsheet, enter values for \( E_{50}^{ref} \), \( E_{oed}^{ref} \), \( E_{ur}^{ref} \), \( m \), \( c'_{ref} \), \( \varphi'_{ref} \), \( \psi \) and \( \nu'_{ur} \) according to Table 5.1. Note that Poisson's ratio is an advanced parameter.
- As no consolidation will be considered in this exercise, the permeability of the soil will not influence the results. Therefore, the default values can be kept in the Flow parameters tabsheet.
- In the Interfaces tabsheet, select Manual in the Strength box and enter a value of 0.5 for the parameter \( R_{inter} \). This parameter relates the strength of the interfaces to the strength of the soil, according to the equations:

\[
c_i = R_{inter} c_{soil} \quad \text{and} \quad \tan \varphi_i = R_{inter} \tan \varphi_{soil} \leq \tan \varphi_{soil}
\]

Hence, using the entered \( R_{inter} \)-value gives a reduced interface friction and interface cohesion (adhesion) compared to the friction angle and the cohesion in the adjacent soil.
- In the Initial tabsheet, define the OCR-value according to Table 5.1.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Soft Clay</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Hardening</td>
<td>Soil model —</td>
</tr>
<tr>
<td>Drainage type</td>
<td>Type</td>
<td>Undrained</td>
<td>A</td>
</tr>
<tr>
<td>Unit weight above phreatic level</td>
<td>$\gamma_{\text{unsat}}$</td>
<td>16.0</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Unit weight below phreatic level</td>
<td>$\gamma_{\text{sat}}$</td>
<td>17.0</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Parameters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secant stiffness for CD triaxial test</td>
<td>$E_{\text{50}}^{\text{ref}}$</td>
<td>2.0 $\cdot$ 10$^3$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Tangent oedometer stiffness</td>
<td>$E_{\text{oed}}^{\text{ref}}$</td>
<td>2.0 $\cdot$ 10$^3$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Unloading/reloading stiffness</td>
<td>$E_{\text{ur}}^{\text{ref}}$</td>
<td>1.0 $\cdot$ 10$^4$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Power for stress level dependency of stiffness</td>
<td>$m$</td>
<td>1.0</td>
<td>—</td>
</tr>
<tr>
<td>Cohesion</td>
<td>$c'_{\text{ref}}$</td>
<td>5</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Friction angle</td>
<td>$\phi'$</td>
<td>25.0</td>
<td>°</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>$\psi$</td>
<td>0.0</td>
<td>°</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>$\nu'_{\text{ur}}$</td>
<td>0.2</td>
<td></td>
</tr>
<tr>
<td>Interfaces</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interface strength</td>
<td>—</td>
<td>Manual</td>
<td></td>
</tr>
<tr>
<td>Interface reduction factor</td>
<td>$R_{\text{inter}}$</td>
<td>0.5</td>
<td></td>
</tr>
<tr>
<td>Initial</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$K_0$ determination</td>
<td>—</td>
<td>Automatic</td>
<td></td>
</tr>
<tr>
<td>Lateral earth pressure coefficient</td>
<td>$K_0$</td>
<td>0.7411</td>
<td></td>
</tr>
<tr>
<td>Over-consolidation ratio</td>
<td>$OCR$</td>
<td>1.5</td>
<td></td>
</tr>
<tr>
<td>Pre-overburden pressure</td>
<td>$POP$</td>
<td>0.0</td>
<td></td>
</tr>
</tbody>
</table>

**Hint:** When the *Rigid* option is selected in the *Strength* drop-down, the interface has the same strength properties as the soil ($R_{\text{inter}} = 1.0$).

Note that a value of $R_{\text{inter}} < 1.0$, reduces the strength as well as the stiffness of the interface.

- Click *OK* to close the window.
- After closing the *Material sets* window, click the *OK* button to close the...
Modify soil layers window.

- In the Soil mode right click on the upper soil layer. In the appearing right hand mouse button menu, select the Soft Clay option in the Set material menu.
- In the same way assign the Soft Clay material to the other two soil layers.
- Proceed to the Structures mode to define the structural elements.

**Hint:** The Tension cut-off option is activated by default at a value of 0 \( kN/m^2 \). This option is found in the Advanced options on the Parameters tabsheet of the Soil window. Here the Tension cut-off value can be changed or the option can be deactivated entirely.

### 5.1.2 Definition of Structural Elements

The creation of sheet pile walls, walings, struts and surface loads is described below.

**Hint:** In the Professional version, the Extrude and Decompose tools can be used to generate the shape of the building in a more convenient way.

Click the Create structure button.

Create a plate between (30 20 0), (30 32 0), (30 32 -11) and (30 20 -11). Press the <Shift> key and keep it pressed while moving the mouse cursor in the -z-direction. Stop moving the mouse as the z-coordinate of the mouse cursor is -11 in the cursor position indicator. Note that as you release the <Shift> key, the z-coordinate of the cursor location does not change. This is an indication that you can draw only on the xy-plane located at \( z = -11 \).
• Create a second plate between (30 32 0), (50 32 0), (50 32 -11) and (30 32 -11), a third plate between (50 32 0), (50 20 0), (50 20 -11) and (50 32 -11) and a fourth plate between (50 20 0), (30 20 0), (30 20 -11) and (50 20 -11).

• Create a data set for the sheet pile walls (plates) according to Table 5.2. Assign the data sets to the four walls.

• Select all four vertical surfaces modelling the sheet pile walls and assign both positive and negative interfaces to them using the options in the right mouse button menu.

**Hint:** The term 'positive' or 'negative' for interfaces has no physical meaning. It only enables distinguishing between interfaces at each side of a surface.

Table 5.2 Material properties of the sheet pile walls

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Sheet pile wall</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>d</td>
<td>0.379</td>
<td>m</td>
</tr>
<tr>
<td>Weight</td>
<td>γ</td>
<td>2.55</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Type of behaviour</td>
<td>Type</td>
<td>Linear, non-isotropic</td>
<td>—</td>
</tr>
<tr>
<td>Young's modulus</td>
<td>$E_1$</td>
<td>1.46 · 10⁷</td>
<td>kN/m²</td>
</tr>
<tr>
<td></td>
<td>$E_2$</td>
<td>7.3 · 10⁵</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>ν</td>
<td>0.0</td>
<td>—</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>$G_{12}$</td>
<td>7.3 · 10⁵</td>
<td>kN/m²</td>
</tr>
<tr>
<td></td>
<td>$G_{13}$</td>
<td>1.27 · 10⁶</td>
<td>kN/m²</td>
</tr>
<tr>
<td></td>
<td>$G_{23}$</td>
<td>3.82 · 10⁵</td>
<td>kN/m²</td>
</tr>
</tbody>
</table>

• Non-isotropic (different stiffnesses in two directions) sheet pile walls are defined. The local axis should point in the correct direction (which defines which is the 'stiff' or the 'soft' direction). As the vertical direction is generally the stiffest direction in sheet pile walls, local axis 1 shall point in the z-direction. In the Model explorer tree expand the Surfaces subtree, set the AxisFunction to Manual and set the Axis$1_z$ to -1. Do this for all the pile wall surfaces.
Table 5.3 Material properties for the walings and struts

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Waling and strut</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross section area</td>
<td>$A$</td>
<td>0.008682</td>
<td>$m^2$</td>
</tr>
<tr>
<td>Unit weight</td>
<td>$\gamma$</td>
<td>78.5</td>
<td>$kN/m^3$</td>
</tr>
<tr>
<td>Material behaviour</td>
<td>Type</td>
<td>Linear</td>
<td>—</td>
</tr>
<tr>
<td>Young's modulus</td>
<td>$E$</td>
<td>$2.1 \cdot 10^8$</td>
<td>$kN/m^2$</td>
</tr>
<tr>
<td>Moment of Inertia</td>
<td>$I_3$</td>
<td>$1.045 \cdot 10^{-4}$</td>
<td>$m^4$</td>
</tr>
<tr>
<td></td>
<td>$I_2$</td>
<td>$3.66 \cdot 10^{-4}$</td>
<td>$m^4$</td>
</tr>
</tbody>
</table>

To define the bottom of the excavation pit with points at $z=-6.5$, follow next steps:

1. **Click the Create surface button.**
   - In the command line, type "30 20 -6.5 30 32 -6.5 50 32 -6.5 50 20 -6.5" to define the bottom of the excavation pit.

2. **Click the Create structure button.**

3. **Click the Create beam button** from the additional tools displayed to create beams (walings) around the circumference at level $z = -1$ m.
   - Click on (30 20 -1), (30 32 -1), (50 32 -1), (50 20 -1), (30 20 -1) to draw the walings. Click on the right mouse button to stop drawing walings.

4. **Create a beam (strut) between (35 20 -1) and (35 32 -1).** Press <Esc> to end defining the strut.

5. **Create data sets for the walings and strut according to Table 5.3 and assign the materials accordingly.**

6. **Copy the strut into a total of three struts at $x = 35$ (existing), $x = 40$, and $x = 45$.**

7. **Create a surface load defined by the points: (34 19 0), (41 19 0), (41 12 0), (34 12 0).** The geometry is now completely defined.
5.2 MESH GENERATION

- Proceed to the Mesh mode.

Create the mesh. Set the Element distribution to Coarse.

View the mesh.

- Click on the Close tab to close the Output program and go back to the Mesh mode of the Input program.

5.3 PERFORMING CALCULATIONS

The calculation consists of 5 phases. The initial phase consists of the generation of the initial stresses using the $K_0$ procedure. The next phase consists of the installation of the sheet piles and a first excavation. Then the walings and struts will be installed. Further excavation will be performed in the phase after that. The last phase will be the application of the additional load next to the pit.

- Click on the Staged construction tab to proceed with definition of the calculation phases.

- The initial phase has already been introduced. Keep its calculation type as $K_0$ procedure. Make sure all the soil volumes are active and all the structural elements are inactive.

- Add a new phase (Phase_1). The default values of the parameters will be used for this calculation phase.

- Deactivate the first excavation volume (from $z = 0$ to $z = -1$).

- In the Model explorer, activate all plates and interfaces by clicking on the
checkbox in front of them. The active elements in the project are indicated by a green check mark in the Model explorer.

Add a new phase (Phase_2). The default values of the parameters will be used for this calculation phase.

• In the Model explorer activate all the beams.

Add another phase (Phase_3). The default values of the parameters will be used for this calculation phase.

Select the soil volume to be excavated in this phase (between $z = -1$ and $z = -6.5$).

In the Selection explorer expand the soil entity and subsequently expand the WaterConditions feature. Click on the Conditions and select the Dry option from the drop-down menu.

Figure 5.3 Water conditions in the Selection explorer

• Deactivate the volume to be excavated (between $z = -1$ and $z = -6.5$).

• Hide the soil and the plates around the excavation.

Select the soil volume below the excavation (between $z = -6.5$ and $z = -9.5$).

In Selection explorer expand the soil entity and subsequently expand the WaterConditions feature.

• Click Conditions and select Interpolate from the drop-down menu.
Preview this calculation phase.

Click the *Vertical cross section* button in the *Preview* window and define the cross section by drawing a line across the excavation.

- Select the $p_{\text{steady}}$ option from the *Stresses* menu.

Display the contour lines for steady pore pressure distribution. Make sure that the *Legend* option is checked in *View* menu. The steady state pore pressure distribution is displayed in Figure 5.4. Scroll the wheel button of the mouse to zoom in or out to get a better view.

![Figure 5.4 Preview of the steady state pore pressures in Phase_3 in a cross section](image)

- Click on the *Close* button to return to the Input program.

Add another phase (Phase_4). The default values of the parameters will be used for this calculation phase.

- Activate the surface load and set $\sigma_z = -20 \text{ kN/m}^2$.

**Defining points for curves**

Before starting the calculation process, some stress points next to the excavation pit and loading are selected to plot a stress strain curve later on.

- Click the *Select points for curves* button. The model and *Select points* window will be displayed in the Output program.

- Define $(37.5 \ 19 \ -1.5)$ as *Point-of-interest coordinates*. 
Figure 5.5 The *Select points* window

- Click the *Search closest* button. The number of the closest node and stress point will be displayed.
- Click the checkbox in front of the stress point to be selected. The selected stress point will be shown in the list.
- Select also stress points near the coordinates (37.5 19 -5), (37.5 19 -6) and (37.5 19 -7) and close the *Select points* window.
- Click the *Update* button to close the Output program.

Start the calculation process.

Save the project when the calculation is finished.
**Hint:** Instead of selecting nodes or stress points for curves before starting the calculation, points can also be selected after the calculation when viewing the output results. However, the curves will be less accurate since only the results of the saved calculation steps will be considered.

To plot curves of structural forces, nodes can only be selected after the calculation.

Nodes or stress points can be selected by just clicking them. When moving the mouse, the exact coordinates of the position are given in the cursor location indicator bar at the bottom of the window.

### 5.4 VIEWING THE RESULTS

After the calculations, the results of the excavation can be viewed by selecting a calculation phase from the *Phases* tree and pressing the *View calculation results* button.

Select the final calculation phase (Phase_4) and click the *View calculation results* button. The Output program will open and will show the deformed mesh at the end of the last phase.

- The stresses, deformations and three dimensional geometry can be viewed by selecting the desired output from the corresponding menus. For example, choose *Plastic points* from the *Stresses* menu to investigate the plastic points in the model.

- In the *Plastic points* window, Figure 5.6, select all the options except the *Elastic points* and the *Show only inaccurate points* options. Figure 5.7 shows the plastic points generated in the model at the end of the final calculation phase.

Start selecting structures. Click at a part of the wall to select it. Press <Ctrl + A> simultaneously on the keyboard to select all wall elements. The selected wall elements will colour red.
While holding the <Ctrl> key or <Shift> key on the keyboard, double-click at one of the wall elements to see the deformations plane of the total displacements $|u|$ in all wall elements.

To generate a curve, select the *Curves manager* option from the *Tools* menu or click the corresponding button in the toolbar.

- All pre-selected stress points are shown in the *Curve points* tabsheet of the *Curves manager* window.
- Create a new chart.
- Select point $K$ from the drop-down menu for $x$−axis of the graph. Select $\epsilon_1$ under *Total strains*.
• Select point $K$ from the drop-down menu for $y-$axis of the graph. Select $\sigma'_1$ under *Principal effective stresses*.

• Invert the sign of both axis by checking the corresponding boxes (Figure 5.8).

• Click *OK* to confirm the input.

![Figure 5.8 Curve generation window](image)

The graph will now show the major principal strain against the major principal stress. Both values are zero at the beginning of the initial conditions. After generation of the initial conditions, the principal strain is still zero whereas the principal stress is not zero anymore. To plot the curves of all selected stress points in one graph, follow these steps:

• Select *Add curve → From current project* from right mouse button menu.

• Generate curves for point L, M and N in the same way.

The graph will now show the stress-strain curves of all four stress points (Figure 5.9). To see information about the markers, make sure the *Value indication* option is selected from the *View* menu and hold the mouse on a marker for a while. Information about the coordinates in the graph, the number of the point in the graph, the number of the phase and the number of the step is given. Especially the lower stress points show a considerable
increase in the stress when the load is applied in the last phase.

Figure 5.9 Stress - Strain curve

**Hint:** To re-enter the *Curve generation* window (in the case of a mistake, a desired regeneration or a modification), the *Curve settings* option from the *Format* menu can be selected. As a result the *Curves settings* window appears, on which the *Regenerate* button should be clicked.

The *Chart settings* option in the *Format* menu may be used to modify the settings of the chart.

To create a stress path plot for stress point $L$ follow these steps:

- Create a new chart.
- In the *Curves generation* window, select point $L$ from the drop-down menu of the $x-$axis of the graph and $\sigma_{yy}'$ under *Cartesian effective stresses*.
- Select point $K$ from the drop-down menu of the $y-$axis of the graph.
Select $\sigma'_{zz}$ under *Cartesian effective stresses*.

- Click *OK* to confirm the input (Figure 5.10).

![Figure 5.10 Vertical effective stress ($\sigma'_{zz}$) versus horizontal effective stress ($\sigma'_{yy}$) at stress point L located near (37.5 19 -5)]